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Using This Manual

Congratulations on your purchase of your Avid ControlAir system. You 
can use your system to create broadcast-quality output incorporating every 
possible production element from full-speed, high-resolution footage, to 
multimedia artwork and animation, to computer-generated effects and 
titling.

This publication provides information on how to use the ControlAir 
system.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware 
that are covered in the documentation. 

Who Should Use This Manual

This manual is written for journalists, producers, directors, writers, and 
various technical personnel responsible for using the ControlAir system in 
a broadcast newsroom.This manual is intended for all ControlAir users, 
from beginning to advanced.

It is strongly recommended that system users have prior experience in or 
classroom knowledge of the Windows 2000 or NT® operating system.
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About This Manual

This manual will lead you through even the most complex procedures with 
task-oriented instructions, illustrated for a more realistic presentation of 
the actual icons and images you will encounter. The information provides 
basic user procedures, while adding a complete explanation of all the tools 
and techniques required to create, apply, and adjust various settings, 
including useful tips, shortcuts, and custom options.

The Table of Contents that precedes this preface lists all topics included in 
the book. They are presented with the following overall structure:The 
Contents lists all topics included in the book. They are presented with the 
following overall structure:

• The Introduction helps you get oriented with beginning concepts and 
general workflow and provides valuable pointers to keep in the back of 
your mind as you proceed.

• The main body of the manual follows the natural flow of your work, 
with clear and comprehensive step-by-step procedures.

• At the back of the book is a comprehensive Glossary, providing cross-
industry terms and definitions.

• Finally, a detailed Index helps you quickly locate specific topics.

This manual provides instruction for your system in the following areas:

• System Architecture & Dataflow

• iNEWS Machine Control Instructions

• The Monitor Server Utility Program

• The ControlAir Workstation

• Configuration and Customization of ControlAir

Use this manual for help in using your system after you have installed 
ControlAir components according to requirements and specifications. 
Before installing any equipment, the site must already have a configured 
network.
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Symbols and Conventions

Unless noted otherwise, the material in this document applies to the 
Windows 2000 operating system.

The ControlAir documentation uses the following special symbols and 
conventions:

1. Numbered lists, when the order of the items is important.

a. Alphabetical lists, when the order of secondary items is important.

• Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

One arrow indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

Courier Bold font identifies text that you type.

Look here in the 
margin for tips.

In the margin, you will find tips that help you perform tasks more easily 
and efficiently.

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this manual or on the unit itself when 
handling electrical equipment.

Cross references are provided throughout this manual to give readers 
locations where additional—sometimes more detailed—information on a 
certain topic can be found. In some cases, the chapter name and number is 
provided. In most cases, a page number is given. 

For instance: See “ControlAir Work Flow” on page 8
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See “About This Manual” on page iv for more information on what 
chapters are in which sections of this manual.

In this example, information on work flows through a ControlAir system 
can be found on page 8 of this manual. Chapters are numbered 
consecutively with page numbers continued from the previous chapter. 
Keyboard Conventions

Ctrl+x means to press and hold down the Control key and then press 
another key on the keyboard, represented here by x. This is also used for 
other key+combinations, such as Alt+x or Shift+x.

“Type” in a command procedure means to type the command on the 
command line and then “press” the Enter key.

“Select” means to choose an operation on a menu.

“Click” means to click the left mouse button, usually in response to a 
dialog box. “Right-click” means to click the right mouse button.

If You Need Help

If you are having trouble using ControlAir, you should:

1. Repeat the procedure, carefully following the instructions provided 
for the task in this guide.

2. Refer to the documentation included with your hardware to review 
the maintenance procedures or the hardware-related issues.

3. Check the Support section of Avid’s Web site at 
http://www.avid.com/support/ for online technical publications and 
additional telephone support phone numbers.

4. Maintenance Agreement contract customers can contact Avid Broad-
cast Customer Support personnel at any of these 24-hour global tele-
phone numbers: 

• 1 800 639 7364 in the Americas (All Broadcast products, except News-

view)

• 44 1256 814222 in Europe, Africa, and Mid-East
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• 61 2 9963 2895 in Asia/Pacific

Or online:

• e-mail support@inewsroom.com

• http://www.avid.com/support/contact.html

For general information, call your local Avid reseller or in North America 
call the Avid Broadcast Customer Relations desk at 1-800-869-7009.

Related Information

Contact your Avid Sales representative for documentation and information 
on other Avid® products, such as the iNEWS™ newsroom computer 
system, Media Browse™, EditStar™, LeaderPlus™, MOS Gateway, 
AirSPACE™, and so forth.

If You Have Documentation Comments

The Avid Broadcast Technical Publications department continually seeks 
to improve its documentation. We value your comments about this manual 
or other Avid-supplied documentation.

Send your documentation comments by e-mail to:

techpubs_wi@avid.com

Include the title of the document, its part number, revision, and the specific 
section that you are commenting on in all correspondence. Please include 
the title of the document, its part number, revision, and the specific section 
you are commenting on in all correspondence. 
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How to Order Documentation

To order additional copies of this documentation from within the United 
States, call the Avid Sales department at 1-608-274-8686. If you are 
placing an order from outside the United States, contact your local Avid 
Sales representative.



Chapter 1

The iNEWS ControlAir™ 

System Overview

This chapter contains the following major sections:

• Overview

• System Architecture

• ControlAir Work Flow
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Overview

The iNEWS ControlAir system is a machine control system for on-air 
operations, which can be integrated into the iNEWS newsroom computer 
system, or into another newsroom computer system. It can also operate in a 
standalone environment if the iNEWS connection is lost.

A ControlAir system normally consists of a server, one or more 
workstations, and several Device Managers (DMs). Also, ControlAir:

• Directly controls production devices

• Receives information from the iNEWS Workstation as control events 
are entered into production cues in scripts

• Handles several shows simultaneously, while enabling shows to be 
produced back-to-back, with only a few seconds between them

Windows-based workstations, with Graphical User Interfaces (GUIs), 
allow production personnel to control events on the ControlAir Server.

Links to Other Newsroom Products

The iNEWS ControlAir system also provides efficient links to other Avid 
products for additional scripting and video capabilities, such as Digital 
News Gathering (DNG), a disk-based production system, which stores 
digital video, audio, and graphics data in a single central library. That data 
is then accessible by workstations for recording, editing, and playback. 
Another feature is the iNEWS CG Title Entry, which enables newsroom 
personnel to simulate character-generated graphics on the iNEWS 
Workstation.

The iNEWS product set is constructed on a modular, open architecture, 
enabling its components to work efficiently not only with other Avid 
products, but also with third-party hardware and software. The iNEWS 
newsroom computer system operates on industry-standard technologies, 
including Windows®-based operating systems, Intel®-based PCs, Intel and 
Silicon Graphics®-based servers, and TCP/IP Internet networking 
protocols.
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Avid publishes open Applications Programming Interfaces (APIs) for 
ControlAir that enables integration with third-party software and hardware.

System Architecture

There are three groups of software in the iNEWS ControlAir system. 

• The ControlAir Server (which includes the casvr.exe and 
AMCPapp.exe executable programs)

• Device Managers (DMs)

• ControlAir Workstation 

Typically, ControlAir Server software and device managers are installed on 
the ControlAir Server, while the ControlAir Workstation is installed on 
computers in each of the control rooms where ControlAir will be operated. 

ControlAir architecture consists of:

• ControlAir Server

- Avid Machine Control Protocol application (AMCPapp.exe)

- ControlAir Server application (casvr.exe)

- ControlAir Manager application (camgr.exe)

• Device Managers

• ControlAir Workstation(s)

• The monitor server utility program - running on the iNEWS Server.

n ControlAir software can be installed on either the Mirror Net or the House 
Net of the iNEWS hosts. If ControlAir components need access to other 
station networking services than just iNEWS Servers, then they should be 
placed on the House network. In either case, static IP addresses and local 
hosts files should be used for all ControlAir components.
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ControlAir Components

There are several components that make up the ControlAir system, 
including the ControlAir Server program (casvr.exe), AMCP 
application (AMCPapp.exe), ControlAir Manager program 
(camgr.exe), device managers, and ControlAir Workstation, which are 
explained in this section.

ControlAir Server

The ControlAir Server is a computer that runs the casvr.exe, 
AMCPapp.exe, and camgr.exe programs, as well as any device 
managers (DMs) that are controlled by that server. It is also possible to run 
ControlAir Workstation software on this computer, if desired, but it is not 
required. For more information on hardware requirements for the 
ControlAir Server, see the iNEWS ControlAir Installation and Operations 
Manual.

casvr.exe

The executable program called casvr.exe is the central program that runs 
on the ControlAir Server. 

The ControlAir Server program:

• Routes status and messages between AMCPapp.exe, device 
managers, and ControlAir Workstations

• Creates and manages playlists and downloads them to their respective 
devices

• Tracks which components have playlists and devices reserved

• Directs control commands from ControlAir Workstation to the 
appropriate device manager (DM).

w If ControlAir Server program (casvr.exe) fails or is stopped, other 
components, such as DMs, must also be restarted. If the ControlAir 
Manager program is set up, it will monitor the ControlAir Server 
program and components and restart them should they stop running. 
Each DM will reconnect at start up to the ControlAir Server and to 
the device(s) it controls. If ControlAir Manager is not used, 
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components of the ControlAir system must be restarted manually. Any 
playlists loaded at the time the ControlAir Server program is stopped 
should be reloaded after the program is restarted.

AMCPapp.exe

The executable program called AMCPapp.exe is the interface between 
Avid’s iNEWS newsroom computer system and the ControlAir Server 
running casvr.exe. It translates Avid Machine Control Protocol (AMCP) 
data coming in from iNEWS—or other newsroom computer system—into 
data that the ControlAir system can manage.

camgr.exe

The executable program named camgr.exe is known as the ControlAir 
Manager. It monitors ControlAir components, including device managers, 
on the ControlAir Server. If a component stops running, the ControlAir 
Manager will restart it automatically.

n ControlAir Manager can also monitor third-party device managers.

Device Managers

A device manager (DM) is an executable program that connects directly or 
via the network to casvr.exe. When the connection is made to 
casvr.exe, the DM will accept playlists from iNEWS and commands 
from ControlAir Workstation. Although DMs can run on other computers, 
Avid recommends they be installed on the ControlAir Server—the same 
computer running the casvr.exe program.

Each DM is designed to control a specific machine. For instance, 
LouthDM.exe is a DM designed to control any video server that 
correctly supports the Louth video device control protocol (VDCP)—such 
as Avid’s AirSPACE series of video servers. 

There are existing DMs that allow the ControlAir operator to control the 
following machine types used for broadcast production:

• Character Generator (CG)
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• Still stores

• Video playback devices

ControlAir Workstation

See Chapter 4 for more 
information.

The ControlAir Workstation provides the operator with a Graphical User 
Interface (GUI) that allows control of broadcast events. From the 
ControlAir Workstation, the ControlAir operator can view playlists that 
have been downloaded from iNEWS, get device and event status, and 
control the broadcast production devices.

The ControlAir Workstation software can run on the same computer as the 
casvr.exe program, or on a separate computer. 

Monitor Server

See Chapter 3 for more 
information. 

The monitor server is not an actual part of ControlAir software, but is a 
utility program on the iNEWS Server. For ControlAir, it is used to scan 
stories in the rundown, searching for machine control events to build event 
lists (playlists) for the production devices. It continues monitoring the 
rundown for changes to machine control events and sends them to the 
ControlAir system until the show goes off the air.
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Figure 1 depicts how connections are made from iNEWS, through the 
AMCP application (AMCPapp.exe), to the ControlAir Server program 
(casvr.exe), then to the ControlAir Workstation, device managers, and 
devices

Figure 1 ControlAir Component Associations
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ControlAir Work Flow

After the news staff has entered machine control events in scripts, the 
producer can download rundowns to ControlAir using the monitor server 
in iNEWS.

n For more information on creating monitor servers, see the iNEWS 
ControlAir Installation and Operations Manual.

From the ControlAir Workstation, production personnel, such as the 
ControlAir operator, can access playlists for downloaded rundowns and 
control associated production devices to cue, play, and stop the production 
events requested.

See Chapter 2 for more 
information.

When your newsroom staff builds a show, they insert special keywords into 
scripts, known as machine control events. These items include a word to 
identify the specific machine or a machine type, such as CG or SS, and 
some information to indicate what they want that machine to display. 

The following example shows a machine control event that instructs the 
character generator to display two lines of text using a saved template 
named LOC2:

*CG LOC2 

Bob Willhouser

Washington DC

Monitor Mode - ON

See Chapter 3 for more 
information.

When the monitor server is turned on—usually by the producer, from the 
iNEWS Workstation’s Tools  menu—it will read all machine control events 
in the rundown and build playlists, also known as event lists, for each 
device. 

After the monitor server is turned on, it continues to monitor the rundown, 
examining every saved story for deleted, new, or updated events in the 
playlist.

The monitor server performs as much error checking as it can without 
communicating with any broadcast equipment.
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The iNEWS ControlAir system is not yet involved. Playlists can be printed 
and distributed to the equipment operators, who can control devices, such 
as the CG, using traditional methods.

Figure 2 shows communication paths after the monitor server is turned on 
from the iNEWS Workstation.

n For more information about iNEWS utility programs known as monitor 
servers, see the iNEWS ControlAir Installation and Operations Manual.
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Figure 2 Monitor Mode - ON Communication Paths
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Monitor Mode - LOAD

As air time nears and the newsroom staff completes the rundown, 
someone—usually the producer or equipment (ControlAir) operator—will 
instruct the monitor server to load the playlist into the ControlAir system 
(via the AMCP application program). See the iNEWS ControlAir 
Installation and Operations Manual.

As the rundown is downloaded to the ControlAir Server, the casvr.exe 
program loads it to the ControlAir Workstation, and loads individual event 
lists or playlists to the appropriate device manager (DM). That DM 
establishes a connection to the device (if it has not already done so) and 
begins its assigned task, such as inserting CG text, checking for availability 
of video clips, and so forth.

Each DM sends to the ControlAir Server program (casvr.exe) the 
status of devices and individual playlists, such as whether video is 
available, and so forth. The ControlAir Server then forwards the data to the 
ControlAir Workstation and iNEWS monitor server (via AMCPApp.exe). 
Error messages are returned to the iNEWS user who loaded the rundown 
and the ControlAir operator. The monitor server also displays status for 
video clips, such as whether the clip is available, into stories in the 
rundown and event lists located in the iNEWS database.

The ControlAir operator may now take control of the playback devices and 
take the show to air.

Figure 3 shows communication paths after the monitor server is instructed 
to load playlists, commands, status, and user messages between ControlAir 
components; note the direction of flow for the four different kinds of data.
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Figure 3 Monitor LOAD Communication Paths
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Monitor Mode - Unload

After the show airs, someone—typically the producer or equipment (Con-
trolAir) operator—will instruct the monitor server to unload the playlist 
from the ControlAir system. The unload mode allows the user to discon-
nect from the ControlAir Server without turning off the monitor server.

See “Using the Monitor Server” on page 26 and Figure 9 on page 27 for 
more information about various modes of the monitor server.
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Chapter 2

Machine Control Events

This chapter contains the following major sections:

• iNEWS Workspace Overview

• Inserting Machine Control Events into Scripts

- Character Generator (CG) and Still Store (SS) Styles

- Video Playback Device
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iNEWS Workspace Overview

The iNEWS workspace consists of three main panels: the Directory panel, 
the Queue panel, and the Story panel. The Story panel displays the story 
text; however, it may be split, as shown in Figure 4, to also show an 
Instruction panel for production cues, a Story Form panel, as well as the 
Story Text panel. It depends on the view specified.

Figure 4 iNEWS Workspace
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Inserting Machine Control Events into Scripts

To insert a machine control event into a script in iNEWS, do the following: 

1. Open the script into the Story panel.

2. Click in the Story panel at the location where the production cue is to 
be placed.

3. Press Alt+Insert. 

An Instruction panel appears to the left of the Story Text panel.The 
Instruction panel has a Production Cue text box where the cursor is placed 
so that a production cue, may be entered. A production cue containing a 
command for a device is known as a machine control event.

A production cue marker (also known as a grommet, shown at left) is 
inserted in the script text at the cursor position. 

In the example shown in Figure 5, the Story panel is split to show both the 
Instruction and Story Text panels, but not the Story Form panel.

Each command is preceded by an asterisk (*) and should be written in a 
special format. 

The format for machine control events, following the asterisk, starts with a 
command for the name of device manager the instruction is for, such as CG 
for a character generator, or SS for a still store device. After the command, 
the format specifies a particular item or template. If additional comments 
or information is required it would follow on succeeding lines in the same 
Production Cue text box.
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A machine control event for a 2-line character generator graphic may look 
like the one shown in Figure 5.

Figure 5 Machine Control Event Example

In the example shown in Figure 5, the Take VO production cue is just 
information for the director; it is not a machine control event. The machine 
control event for the character generator is in the second Production Cue 
text box. 

n Machine control event formats will vary based on styles set up by your 
system administrator. Check with your system administrator for a list of 
styles used at your location.

Production cues may include the following: Take VO, On Camera, Take 
SOT, and Take Live. When using ControlAir, production cues may include 
machine control events to character generators (CGs), still stores (SS), 
video playback devices, such as Betacart machines (CART), digital video 
playback. 

n By default, iNEWS generally refers to all video playback devices as 
“CART” type devices, including high resolution video servers, such as an 
AirSPACE video server.

Some typical machine control events in a script are shown in Figure 6.
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Figure 6 Machine Control Events in a Script

Machine control events are easily identified in a script; they appear in the 
Instruction panel, are preceded by an asterisk, and are colored blue.

Character Generator (CG) and Still Store (SS) Styles

The machine control event command *CG is followed by the style used 
for the caption. Styles are specific to individual stations and are generally 
set up by the system administrator. 

There is a unique style for each type of CG that is used during the 
broadcast. For instance, in the following example, 2line, 1line, place name. 

*CG 2line TONY BLAIR

Prime Minister

*CG 1line NATHANIEL LOYD

*CG place NORTH WALTHAM

Following the style is the actual text that ControlAir will send to the 
character generator to build the CG.
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A full frame CG can be recalled by replacing the style with a page number, 
as in the following example:

*CG 888

The preceding example will recall page 888 from the character generator, 
without writing any text to the page.

The *SS command is also followed by either a style (logo-right) or still 
store number (1234), as shown in Figure 6. The system administrator sets 
up the styles for frequently used graphics and assigns numbers used to 
create new graphics daily.

ControlAir will use the style or number to recall the particular still in the 
proper manner during the broadcast.

Video Playback Device

Use the Story Form panel to enter the Video ID into iNEWS. This allows 
the Video ID to be viewed from the rundown. During the broadcast, 
ControlAir will report the video event status to the Event Status field of the 
iNEWS rundown, in the Queue panel.

When the Video ID is entered in the Video ID field in the Story Form 
panel, those video events will appear first on ControlAir and in the 
composite playlist. They appear ahead of CG or still store’s in the script, 
regardless of whether a CG needs to be taken before rolling the tape.

When an accurate, sequential listing of all events on ControlAir and in the 
composite list is required, the events must be entered in the body of the 
script as production cues. If they are not put into form fields, ControlAir is 
unable to report the status back to the Event Status field on the iNEWS 
rundown in the Queue panel. Also, the ability to use the color rules in the 
rundown to alert to an empty Video ID field is lost.
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For instance, if a story contains a presenter on set with a still store graphic 
over the shoulder, then the presenter's name gets superimposed onair. Next, 
a tape is rolled, and a locator CG (super) is inserted. The script would need 
production cues in the following order, so all events appear in the order that 
they are required during the show. 

*SS ots 1001

*CG 2line

Amy Anchor

Newswatch Eleven on Your Side

*CART 23456

*CG loc

Downtown Boston

If the cart number was placed in a Video ID field instead of in the body of 
the script, the ControlAir Workstation and composite list would show the 
following order:

cart 23456 

ss 1001

cg Amy Anchor

cg Downtown Boston

If you want the tape number in the Video ID field for status feedback 
purposes, the still store graphic and CG event containing the presenter’s 
name could be in a separate script, such as a Lead-In or Intro. Then, the 
tape number is placed in the Video ID field, with the next CG inside the 
story. In this case, the ControlAir Workstation and composite list would 
show the following order:

ss 1001

cg Amy Anchor

cart 23456 

cg Downtown Boston
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Figure 7 iNEWS Rundown

The control room staff can quickly see from the rundown, which items still 
require a Video ID while the show is being prepared. When the Video ID is 
entered, the entire line changes color. When using more than one video 
channel during the broadcast, there are a number of ways to assign the 
playout channel for each item. Playout channels may be assigned by the 
device itself, from the iNEWS rundown, or by ControlAir, either manually 
or automatically.

For video servers, such as AirSPACE, or for video playback devices, the 
channel may be assigned through the iNEWS rundown in the Video ID 
column. It may also be done in the rundown by adding the playout channel 
to the Video ID Form field . For example: 72951*A—as shown in 
Figure 8—instructs ControlAir to play a video with an ID of 72951 
through video output channel A on a video playback device or video 
server.

If no channel is assigned by the script, the video event will be assigned a 
channel by the DM or ControlAir depending on your local configuration 
which is determined by the iNEWS system administrator.
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Figure 8 Channel Assignment Through a Script
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Chapter 3

The Monitor Server Utility 
Program

After the iNEWS ControlAir software is installed, monitor servers must be 
set up on iNEWS Servers to use ControlAir.

This chapter contains the following sections:

• Overview

• Using the Monitor Server

• Monitor LOAD

• Monitor Off and Unload

• Quit Time

• Event List Queue

• Composite Queue

• Correcting Errors
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Overview

Monitor server is a utility program—running on the iNEWS newsroom 
computer system—that checks a show’s event requests for errors, creates 
composite and event lists, and sends playlists to ControlAir.

The monitor server is turned on when a user at an iNEWS Workstation 
turns it on. When on, monitor server checks its assigned rundown for 
machine control events, and builds playlists. It continues to monitor the 
rundown for changes and performs as much error checking as it can—by 
comparing machine control events with styles located in the 
SYSTEM.RESOURCE queue—without communicating with any broadcast 
equipment, including ControlAir. See “Monitor Mode - ON” on page 8 
and “Monitor Mode - ON Communication Paths” on page 10 for more 
information. 

The monitor server loads data to the ControlAir system when a user 
instructs it to do so from an iNEWS Workstation. The communication 
paths between monitor server and ControlAir, at this point, are explained 
in more detail in “Monitor Mode - LOAD” on page 11. See also “Monitor 
LOAD Communication Paths” on page 12.

n It is recommended that producers or production assistants turn the monitor 
server on as show time approaches so it can check the rundown queue 
throughout much of the show’s development. Monitor server scans through 
the scripts and builds Event Lists for CG, CART, and SS if these events are 
present in the scripts. Monitor Server will also create a Composite list if 
configured to do so. Instructing the monitor server to load data should be 
done later such as, just before taking the show to air.

Using the Monitor Server

This section provides some basic user information about the iNEWS 
feature called monitor server. Procedures include how to turn the monitor 
server on and off, as well as how to instruct it to load or unload machine 
control event data.
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To use the monitor server, log in to an iNEWS Workstation, and do the 
following:

1. Open the appropriate rundown queue.

2. Click Tools > Monitor.

For more information 
on Quit Time, see “Quit 
Time” on page 30. 

The Monitor Queue dialog box appears. The Quit Time or automatic 
shut-off time appears at the bottom of the dialog box.

Figure 9 Monitor Queue Dialog Box

3. Select a monitor mode based on the following options:

• On  - Turns the monitor server on and creates an event list for 
each device in the rundown queue.

• Load  - Instructs the monitor server to load event lists to 
devices you select. See “Monitor LOAD” on page 29 
for more information.

• Unload - Disconnects from the selected device or server without 
turning the monitor server off. (If all devices/servers 
are unloaded, the monitor server returns to the On 
mode. See “Monitor Off and Unload” on page 29 for 
more information.
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• Off - Turns the monitor server off, overriding the Quit Time 
setting. See “Monitor Off and Unload” on page 29 for 
more information.

The Devices section of the Monitor Queue dialog box displays a list of 
available devices.

The list could include: 

- Specific devices, such as those connected through an MCS-PC 
or PC-PCU

- Servers, such as the ControlAir Server and/or MOS Gateway 
Server

If you select Load, specify the device or server to load from the 
Devices list, or select the All Devices checkbox to load all devices 
associated with the rundown queue. To select up to three devices from 
the list, without selecting all, press the Ctrl key while you click on each 
item. If you select a server, the data will be loaded to all devices 
associated with that server. 

If you select the MOS Gateway Server that is interfacing with a device 
that has multiple channels, such as an OmniBus automation system, a 
second dialog box will appear, allowing you to select the channel from 
a drop-down list. 

Click OK to return to the previous dialog box.

4. Click OK.
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n For more information on the monitor server, refer to the iNEWS ControlAir 
Installation and Operations Manual.

Monitor LOAD

Before ControlAir is able to view the list of machine control events and 
control them for playback, they must be loaded from the rundown in 
iNEWS. The procedure for using monitor server to load events is on page 
26.

Events are loaded from iNEWS to ControlAir and then communicated to 
appropriate devices. After ControlAir receives the entire lists, it will notify 
the user that it has received the list by sending a message to the iNEWS 
Workstation. Confirmation messages may look like the following:

LIST RECEIVED “SHOW.5P.Rundown

SHOW.5P.RUNDOWN: Download Complete

If the monitor server is not on, loading events will automatically switch the 
monitor server on.

Monitor Off and Unload

Monitor Off is used after the show is over. Switching the monitor server off 
stops the system from scanning scripts for updates and sending those 
updates to ControlAir. 

If ControlAir has already reserved the show, the broadcast may continue 
but no updates from iNEWS will be received. If ControlAir has not 
reserved the show, switching the monitor server off removes the playlist 
from the ControlAir Workstation.

Monitor Unload clears the ControlAir playlist, if ControlAir has not 
reserved the show, but continues to scan the scripts and update the event 
lists with changes.
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Quit Time

Monitor server uses a large amount of system resources. If monitor servers 
are left on after the end of their shows, they could degrade the efficiency of 
the iNEWS system.

To protect system resources, a Quit Time may be set by the system 
administrator. This will automatically switch off the monitor server at the 
specified time, ensuring the integrity of the system. However, for the best 
results, Avid recommends that monitor servers be manually turned off at 
the end of each show.

The Quit Time or automatic shut-off time appears at the bottom of the 
Monitor Queue dialog box, as shown in Figure 9 on page 27.

Event List Queue

After the monitor server is on for a few seconds, event lists are built. The 
Event List queues are generally built in the same folder as the rundown, 
such as:

Rundown: SHOW.6PM.RUNDOWN

CG Event List: SHOW.6PM.CG

SS Event List: SHOW.6PM.SS

CART Event List: SHOW.6PM.CART
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Any script or rundown changes will be picked up automatically by the 
monitor server, which will then make the appropriate changes in the event 
lists. All changes must be made in the rundown queue, not in the event 
build queues. The following Figure 10 shows a CG event queue for a 
rundown, listing the CGs for that show.

Figure 10 Rundown Queue

Composite Queue

It is possible to configure iNEWS to also create a Composite List queue. 
This is a single queue that contains a list of all machine control events in 
the rundown that are required during the show. This list represents what 
will be seen on the ControlAir Workstation. The Composite List Queue is 
usually found in the same folder as the rundown, such as:

Composite List Queue: SHOW.6PM.COMPOSITE
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Figure 11 Composite List Queue

Correcting Errors

Message alerts are sent to the iNEWS Workstation when monitor server is 
on and finds errors in scripted events. After a show is loaded, if the monitor 
server finds an error, it also sends a message to the ControlAir 
Workstation. No indication is sent to ControlAir if the show is not loaded.

There are a number of reasons for the monitor server to see errors in 
events. For instance, the monitor server may not recognize the style used or 
there may be errors in the device name.

n The monitor server will not detect spelling mistakes in a CG text. Run the 
spell check over the scripts to find these types of errors. 

Events must be corrected in the script, not in the Event List queue, which is 
only written to by the monitor server and should be read only to the user.



Correcting Errors

33

In iNEWS, when opening a script containing an error, the left-hand side of 
the script—known as the Instruction panel—will appear red, and the 
production cue containing the erroneous machine control event, will be 
highlighted in yellow.

Figure 12 Correcting Errors in Scripts

After correcting an error, save the script and the monitor server will make 
the appropriate changes to the Event List queue.
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Chapter 4

ControlAir Workstation

This chapter explains how to use the ControlAir Workstation. This chapter 
is made up of the following sections

• Overview

• Using the ControlAir Workstation

• Troubleshooting
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Overview

The ControlAir system allows the user to control the machine control 
events in a show. 

To start the ControlAir Workstation, do the following:

1. Double-click on the ControlAir Workstation icon on the Windows 
desktop.   

The Connect to Server dialog box appears as shown in Figure 13.

Figure 13 Connect to Server Dialog Box

The dialog box prompts for the name of the ControlAir Server to use. 
The first time the ControlAir Workstation is launched, this dialog box 
will contain the workstation’s local machine name by default.

2. Enter the server name in the ControlAir Server text box.

3. Click OK.

The ControlAir Workstation is displayed and ready for use.

The ControlAir User Interface

The ControlAir Workstation graphic user interface (GUI) is shown in 
Figure 14.
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Figure 14 ControlAir Workstation GUI

The Title bar displays the name of the ControlAir Workstation file 
currently open.

The Menu bar displays the ControlAir Workstation menus: File, Broadcast, 
View, and Help.

The File menu contains the following selections:

• Open—allows access to other CAW files—that is, files with the tag 
.caw. CAW files allow operators to save and recall their own 
preferences.

• Save—saves changes to the current *.caw file.

• Save As—saves the current *.caw file with another name.

• Exit—exits the ControlAir Workstation.

Message History List

Expand or Show Loaded 
Collapse Control From iNEWS

Title Bar Menu Bar
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n In earlier versions of the ControlAir software, the tag for these files was 
.bcw not .caw, so they were known as BCW files. Which tag is used 
depends on which version of software a site has. For the purposes of this 
manual, CAW is used.

The Broadcast menu contains the following selections:

• Cue—cues an event to get ready to play.

• Play—plays an event.

• Pause—pauses the event that is playing. To restart the event, use the 
Pause command a second time or the Play command.

• Stop—stops an event.

• Reserve Playlist—reserves a playlist ready to broadcast.

• Release Playlist—releases a playlist from the reserve status.

• Cycle Channels—changes channel assignment to the next channel 
according to ControlAir Workstation setup.

• Change Channel—allows manual channel selection from an offered 
list.

• Rescan a Device—allows rescanning an Avid AirPlay connected to a 
Media Server to detect new media in the bins. 

• Connect to Server—allows selection of a ControlAir Server or to 
reconnect to a server if a connection has been lost.

• Options—allows access to configure and customize the ControlAir 
Interface.

The View menu determines what portions of the ControlAir Workstation’s 
graphic user interface is displayed on screen. It contains the following 
selections:

• Toolbar—contains control buttons for some broadcast commands 
including, Play, Cue, Stop, Pause.

• Status Bar—allows viewing of the bottom status bar giving the 
connection status of the ControlAir Workstation to the ControlAir 
Server.

• Clocks Bar—allows viewing of the Elapsed Time, Time Left, Playlist 
Devices and Local Time Toolbars.
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• Device Bar—allows viewing of the Device Status Bar.

• Clear Error Log—clears errors from the Message History list, shown 
in Figure 14.

• View Error Log—allows viewing of the Message History list.

The Help menu contains the following selections:

• Help Topic—provides access to the ControlAir Workstation online 
help system.

• About—displays ControlAir Workstation version number of the 
product.

The main toolbar as shown in Figure 15, has a  list—known as the Message 
History list—that provides a historical list of the past 21 system messages, 
such as initialization and disconnect notices, with the most recent 
appearing on screen It also displays any errors associated with the 
ControlAir Server, AMCP application and ControlAir Workstation.The 
button located to the left of this text box, marked X, may be used to clear 
messages.

Figure 15 Partial View of the ControlAir WorkstationScreen

Message History List
Playlist Devices Section

Device Bar

Toolbar

Elapsed Time Section
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The ControlAir Workstation toolbar is used to play, cue, stop, rescan, and 
pause an event.The button located to right of these buttons, marked X, may 
be used to clear messages that appear in the Message History list.

The Elapsed Time displays the amount of time that has elapsed during the 
playout of a video event.The Time Left displays the time remaining in a 
CG animation or video event currently playing.

The Playlist Devices, as shown in Figure 15, displays a list of the devices 
being used by ControlAir and their status.The names in the status section 
correspond to the name of the device managers. The status conditions may 
be one of the following: On-Line, Off-Line, Ready, In Use, Unknown and 
Busy.

When the ControlAir Workstation starts, the Device bar will not appear 
automatically in the window. It appears after the iNEWS monitor server 
loads a rundown. At that time, the monitor server checks the show’s list of 
devices in the SYSTEM.MAP story and verifies whether device managers 
(DMs) are running on the ControlAir Server for each device; Their status is 
then displayed on the Device bar, as shown in Figure 15. 

The Device bar will remain displayed even after the first rundown is 
unloaded and as long as the ControlAir Workstation window remains open, 
but the black status fields of the bar are cleared.

The DMs listed on the bar are not necessarily used by the current rundown 
queue; that is, the rundown may or may not have a playlist for the device 
associated with the DM. Those actually used by the loaded rundown are 
shown in the Playlist Devices section when the rundown is reserved from 
the ControlAir Workstation. In either case, the device name and its status 
appear. 
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There are several status possibilities that are color-coded for easy visual 
recognition
Table 1 Status of Devices

Status Color Explanation

On-Line Green Indicates the DM for the named device is 
running, connected to the ControlAir Server, 
and communicating with the device. However, 
control of the device has not yet been reserved 
by a ControlAir Workstation.

In-Use Green Indicates the DM for the named device is 
running, connected to the ControlAir Server, 
communicating with the device, and control 
of the device is reserved by this ControlAir 
Workstation.

Busy Green Indicates the same things as In-Use, except 
that control of the device is reserved by 
another ControlAir Workstation.

Ready Yellow Indicates a DM for a certain device is running 
on the ControlAir Server and ready to 
communicate with the device, but no 
communication between DM and device has 
happened.

n Ready does not indicate an actual connection between the 
device and ControlAir Server.

Off-Line Purple Indicates ControlAir can communicate with 
the DM for this device, but the device is not 
available to be controlled by ControlAir; can 
indicate problems with the DM’s connection 
to the device.

Unknown Red Indicates a DM for this device is not running 
or is no longer connected to the ControlAir 
Server. It can also indicate a mismatched 
device name; ensure that the device names in 
the SYSTEM.MAP file and device manager’s 
DMP file are correct.
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The Local Time display shows the workstation’s local time.

Expand and Collapse buttons. Clicking on the plus sign (+) will expand the 
show to reveal the individual broadcast events. The plus sign (+) will 
become a minus sign (-) when the event is expanded.

Column headers appear above the name of the show as shown in Figure 16. 

Figure 16 ControlAir Event Display Expanded Show

The following may appear:

• Page—displays the page number and story number assigned to the 
story on the iNEWS rundown.

• Slug/Description—displays the story title from the iNEWS rundown.
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• Status—displays the status of an event. Event status, default colors and 
descriptions are shown in Figure 2 on page 4-45.

• Channel—displays the channel that this event will play on, as reported 
by the device manager.

• Duration—displays the duration in hh:mm:ss format of the video 
event as reported back from the device.

• Media ID—displays the different types of event IDs such as, tape 
names for Betacarts or the media clip names for video servers.

• Device displays the name of the device such as,CG, SS or Cart used for 
an event.

• Inventory—indicates the status of video events where more than one 
video channel is configured on a video server(s) under the control of 
one Device Manager. A Full Block indicates Video is not available on 
that channel and a Thin Block indicates Video is available on that 
channel. A half filled Block indicates an incomplete event.

When a Character Generator (CG) is used there may be headers such as, 
Style, Format, and Effect that pertain to colors, fonts, or special effects 
used by the CG operator.

Optional Alternative ControlAir Keyboard

An optional piece of equipment that may be included in a ControlAir 
Workstation may be an alternative keyboard, such as the type 
manufactured by Genovation. This keyboard is smaller and eliminates the 
need for a standard sized keyboard in the production area. It is mapped to 
the keys on the number pad on the standard keyboard.

Using the ControlAir Workstation

Using ControlAir to control a show consists of three primary tasks:

• Reserving a Playlist

• Controlling Events Through Devices in a Playlist

• Releasing a Playlist
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Reserving a Playlist

After ControlAir Workstation has started and a show is downloaded from 
iNEWS, ControlAir displays a list. Confirmation of the download is seen 
in the ControlAir Workstation Message History list, as shown in Figure 17. 

Figure 17 Download Confirmation Message

Controlling events in the show for playback is not enabled until the playlist 
is reserved for that show. 

To reserve the playlist for the show, do one of the following: 

a. Select the show by clicking on the show name—such as, 
SHOW.6PM RUNDOWN—then, press the R key. 

-OR-

b. Select Broadcast > Reserve Playlist.

To verify confirmation of the playlist reservation, Reserved by 
controlair-2 now appears next to the show name, as shown in 
Figure 14 on page 4-37.

After the playlist is reserved, double clicking on the show name will 
display the event list. An event may now be played by placing the cursor on 
the event and clicking the Play button or pressing the Enter key. There is 
also a Play option located in the Broadcast menu. After the show is 
reserved no other ControlAir Workstation may take control of that show.

n It is possible to override control of a playlist from another ControlAir 
Workstation with a password. See Table 3 and “Controlling Events 
Through Devices in a Playlist” on page 46 for more information.

Understanding the Event List & Event List Status

Table 2 shows the types of event status, their default color representations, 
and a description of the type status.
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The event list displayed on the ControlAir Workstation includes the page 
number and slug for every story in the rundown. When a story has events, 
these will be listed under the story title, one line for each event. Character 
Generator (CG) events display the text, the CG page number, status, and 
device name. Video events display nothing in the Slug/Description column 
but display their Media ID, status, channel, duration, device name, and 
inventory.

Table 2 Event Status, Default Colors, & Descriptions

Type of Event Status Default Color Representation Status Description

Cued Yellow The event is prepared to play.

Pause Yellow The video is paused, press pause or 
play to resume.

?Cued? Yellow An intermediate status before a 
video is cued.

Playing Green An event is playing.

Standby Yellow The next event to be cued on a 
channel.

Unavailable Magenta An event cannot be located or does 
not exist. Corrective action is 
required. 

Unknown Red An event has just arrived and the 
Device Manager has not yet 
processed the event request. From 
an Unknown status, an event can 
go to either Available or 
Unavailable.
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Controlling Events Through Devices in a Playlist 

In order to control an event the cursor must be on it. Table 3 shows the type 
of control and how to issue the control command.

During a broadcast, as events are played by pressing Enter on the keypad, 
the cursor will automatically advance to the next event in the show. If an 
event that is playing needs to be re-cued, it must first be paused first.

Table 3 Type of Event Control & Command Instruction

Type of Event Control Command Instruction

Cueing an Event Press Delete on the keypad.

Playing an Event Press Enter on the keypad.

Pausing an Event Press the number 1(one) on the 
keypad.

Stopping an Event Press the number 0(zero) on the 
keypad.

Overriding a Channel Assignment Press the numeric key on the 
keyboard, corresponding with the 
channel you want. For instance, 
press 1 for channel A, 2 for B, and 
so forth.

Rescanning a Device (AVID 
AirPlay ONLY)

Press the Insert key on the keypad

n It may be necessary to rescan a device when a device has failed 
to load properly. From the Broadcast menu choose Rescan 
Device or press Insert on the keyboard. Before rescanning a 
device, the device must be identified in the Rescan Device tab.

Override Control of a Playlist Reserve the already reserved 
playlist. The Override dialogue 
box appears requesting a 
password. Enter the password.
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Making On-Air Changes

When a producer makes changes to an iNEWS rundown, it is reflected on 
the ControlAir Workstation event display. When stories are floated, they 
disappear from the ControlAir Workstation display. When a story's events 
are Cued, ControlAir will automatically Cue the events for the next story. 
When floated stories are reinstated, they reappear on the ControlAir 
Workstation display. Reinstated story's events will be re-cued according to 
their position in the rundown.

When a story is deleted from the iNEWS rundown, the item disappears 
from the ControlAir Workstation display. If a story that has an event 
currently playing is deleted from the iNEWS rundown, the event will 
continue to play. When the event is stopped or finishes playing the item is 
deleted from the ControlAir Workstation display.

When a story is inserted in the iNEWS rundown, it will appear on the 
ControlAir Workstation display even if it contains no events. Machine 
instructions are passed to the ControlAir Server when the story is saved.

Changes to the order of the stories are also reflected on the ControlAir 
Workstation display.

Releasing a Playlist

It is not possible to release a playlist if any of the events are playing.

To release a playlist, do the following:

1. Release the playlist by clicking on the show name and press the letter 
U on the keyboard.

Exiting the program by clicking on the X button in the upper-right-corner 
of the window will also release the playlist.
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Troubleshooting

Status

When ControlAir Workstation is started and initialized, and after a show is 
loaded, the devices connected to the server indicate their status. The device 
status must be on-line before a device may be used.

Playlist is Not Received 

When a playlist is not received by ControlAir Workstation, return to the 
iNEWS rundown, unload the monitor server, and load it again.

Red Event Display Color

If all the events in the ControlAir Workstation display suddenly change to 
red and show something other than a normal status, it is likely the 
ControlAir has lost its connection to the device manager(s). If ControlAir 
Manager is running, it should restart the device manager(s) automatically. 
If not, contact your iNEWS system administrator for assistance.

Device Polling

Some broadcast devices can notify their device manager when they are 
back online. Some ControlAir DMs are designed to poll their devices at 
specified intervals. All DMs are designed to try to bring devices back 
online so ControlAir can use the devices without having to restart the DMs.



Chapter 5

ControlAir Configuration & 
Customization

When the ControlAir Workstation is launched the default CAW file is used 
which contains the default session settings. ControlAir users may 
personalize their sessions and save them under a different file name for 
future use. 

n In earlier versions of the ControlAir software, the tag for these files was 
.bcw not .caw, so they were known as BCW files. Which tag is used 
depends on which version of software a site has. For the purposes of this 
chapter, CAW is used.

This chapter explains how to configure and customize a ControlAir 
session. This chapter contains the following main sections:

• Opening and Saving User Configured Options

• Changing Default User Preference Options
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Opening and Saving User Configured Options

To open a CAW file, do one of the following:

a. Select File > Open.

-OR-

b. Press Ctrl+O.

An Open dialog box appears. Select a CAW file to work with.

To save a CAW file, do one of the following:

a. Select File > Save.

-OR-

b. Press Ctrl+S.

This updates the existing file.

To save a CAW file as a different file, do the following:

1. Select File > Save As. A Save As dialog box appears.

2. In the File Name list box, enter a name for the file.

3. Click the Save button.

The file is now saved under the new name.

Changing Default User Preference Options

ControlAir has user preferences set by default and also allows users to 
customize their preferences. The following options may be customized:

• Colors

• Fonts

• Screen

• Channel Policy

• Rescan Device

• Event Display Columns
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Colors

ControlAir allows users to customize the event status text and background 
colors rather than using the default selections. To customize these options, 
do the following:

1. Select Broadcast > Options.

The Options dialog box appears, as shown in Figure 18.

Figure 18 Options Dialog Box Colors Tab

2. Select the Event Status to change from the Event Status list.

3. Click the Text Colors button to change the color of the text. See 
Table 2 on page 45 for more information.

4. Click the Back Colors button to change the color of the background.

5. Click OK.

6. Select File, then do one of the following:
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a. Select Save to save the changes to this file.

-OR-

b. Select Save As to save the file with changes, using another file 
name.

Fonts

To customize the text font rather than using the default selections the 
following:

1. Select Broadcast > Options.

The Options dialog box appears, as shown in Figure 18 on page 5-51.

2. Select the Fonts tab, as shown in Figure 19.

Figure 19 Options Dialog Box Fonts Tab
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3. Select the category to change from the category list. The categories 
and their descriptions are shown in Table 4.

4. Click the Fonts button to change the font of the text.

On an Arabic-enabled 
NT-based system, 
select Arabic fonts and 
ControlAir Workstation 
will run in Arabic.

5. Click OK.

6. Select File, then do one of the following:

a. Select Save to save the changes to this file.

-OR-

b. Select Save As to save the file with changes, using another file 
name.

Screen

To customize the on-screen cursor positions relative to the bottom of the 
screen during the broadcast rather than using the default selections, do the 
following:

1. Select Broadcast > Options.

The Options dialog box appears, as shown in Figure 18 on page 5-51.

2. Select the Screen tab, as shown in Figure 20.

Table 4 Categories and Descriptions

Category Descriptions

Events All text in an Event row.

Stories All text in a Story row.

Playlists Show name banner at the top Event display.
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Figure 20 Options Dialog Box Screen Tab

3. Enter a percentage number in the enter display scroll position in 
percentage text box.

4. Click OK.

5. Select File, do one of the following:

a. Select Save to save the changes to this file.

-OR-

b. Select Save As to save the file with changes, using another file 
name.

Channel Policy

The Channel Policy tab allows definition of assignment and override 
methods for the video events in a playlist.
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The CAWS Assignment Method is either Single Channel or Rolling—that 
is , alternating channels—for instance, A,B,A,B, depending upon the 
number of channels available.

The Override Method may be either Strong or Weak. This is only relevant 
for a Rolling CAWS Assignment Method. Strong means ControlAir will 
automatically reassign channels to maintain the Rolling (A,B,A,B) CAWS 
Assignment Method. Weak means that ControlAir will not re-assign the 
channels when a new video event is inserted into the rundown.

To define CAWS Assignment and override Methods, do the following:

1. Select Broadcast > Options.

The Options dialog box appears, as shown in Figure 18.

2. Select the Channel Policy tab, as shown in Figure 21.

Figure 21 Options Dialog Box Channel Policy Tab
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3. From the CAWS Assignment method list box, select one of the 
following:

a. Single Channel 

-OR-

b. Rolling (A,B,A,B)

4. From the Override Method list box, select one of the following:

a. Strong—ControlAir will automatically reassign channels to 
maintain the Rolling (A,B,A,B) CAWS Assignment Method.

-OR-

b. Weak—ControlAir will not re-assign the channels when a new 
video event is inserted into the rundown.

5. Check the Enable Cycle Channel key check box, if required.

6. Click Apply.

7. Click OK.

8. Select File, then do one of the following:

a. Select Save to save the changes to this file.

-OR-

b. Select Save As to save the file with changes, using another file 
name.

Rescan Device

The Rescan Device tab is only used to enter an Avid AirPlay® device 
name. It does not apply to any other devices. To enter an Avid AirPlay 
device name, do the following:

1. Select Broadcast > Options.

An Options dialog box appears, as shown in Figure 18 on page 5-51.

2. Select the Rescan Device tab, as shown in Figure 22.
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Figure 22 Options dialog Box rescan Device Tab

3. Enter the Avid AirPlay device name in the Enter the Device Name text 
box.

4. Click Apply.

5. Click OK.

6. Select File, then do one of the following:

a. Select Save to save the changes to this file.

-OR-

b. Select Save As to save the file with changes, using another file 
name.

Event Display Columns

The Event Display columns on the ControlAir Workstation may be 
rearranged to suit a users preferences. 
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To rearrange a Event Display column do the following:

1. Click on the Event Column heading to select the entire column.

2. Drag and drop the heading to a new location. 

3. Select File, then do one of the following:

a. Select Save to save the changes to this file.

-OR-

b. Select Save As to save the file with changes, using another file 
name.

The column widths may also be adjusted and saved in this manner. 
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